
Tobii Sono Flex User’s Manual

User’s Manual

Celebrating  Communication

For Tobii™ Communicator



Tobii Sono Flex User’s Manual
for Tobii Communicator

Manual Version 1.0
09/2011 
All rights reserved.
© Tobii Technology AB

The information contained in this document is 
proprietary to Tobii Technology. Any reproduction in 
part or whole without prior written authoriztion by 
Tobii Technology is prohibited.

Products that are referred to in this document may be 
either trademarks and/or registered trademarks of the 
respective owners. The publisher and the author make 
no claim to these trademarks.

While every precaution has been taken in the 
preparation of this document, the publisher and 
the author assume no responsibility for errors or 
omissions, or for damages resulting from the use of 
information contained in this document or from the 
use of programs and source code that may accompany 
it. In no event shall the publisher and the author be 
liable for any loss of profit or any other commercial 
damage caused or alleged to have been caused directly 
or indirectly by this document.

Content subject to change without notice. 
Please check Tobii web site www.tobii.com for 
updated versions of this manual.

Tobii_manual_SonoFlexCommunicator_V1_0_01092011_UsEng



Contents

Introduction� 6
1.1 Intended Use � 7
1.2 Sono Flex within the Sono Suite� 8
1.3 Fitzgerald Key Categorization� 9
1.4 Two Different Start Pages� 9

Getting Started with Sono Flex� 11
2.1 Installing, Running and Updating Sono Flex� 11
2.1.1 Installing Sono Flex from a CD� 11
2.1.2 Running Sono Flex� 11
2.1.3 Updating Sono Flex or Communicator� 13
2.1.4 Activating Sono Flex� 13
2.2 Quick Guide� 14
2.2.1 Using Sono Flex to Communicate� 14
2.2.2 Exiting Sono Flex� 14

Using Sono Flex� 15
3.1 Common Vocabulary Home Page (Default)� 15
3.1.1 Fitzgerald Key Category Pages (1.1)� 16
3.1.2 Core Words (1.2)� 17
3.1.3 Flex Context Buttons (2)� 18
3.2 Context Based Home Page� 19
3.3 Common Functions� 21
3.3.1 Word Magic button (3)� 21
3.3.2 Message window/speak button (4)� 21
3.3.3 Erase button� 21
3.3.3.1 Delete Last (5.1)� 21
3.3.3.2 Clear All (5.2)� 22
3.3.4 Common buttons� 22
3.3.4.1 Home Button� 22

3.3.4.2 Back Button� 22

3.4 Context Display Page (More Contexts) (6)� 23
3.4.1 Context Display Page, Flexible Contexts� 23
3.4.1.1 Changing a Flex Context Button (9, 10)� 24

1

2

3



3.4.2 Context Display Page, Static Context� 25
3.5 Links and Options� 27
3.5.1 Ready-made Communicator Pages� 27
3.6 Adjusting the Volume� 28
3.7 Exiting Sono Flex� 29
3.7.1 Exiting Sono Flex� 29
3.7.2 Accessing the Control Panel� 30

Sono Flex Control Panel� 31
4.1 Context Display� 31
4.1.1 Add new Flex Context Page� 31
4.1.1.2 Alphabetically View� 32

4.1.1.2 Grouped View� 33

4.1.2 Remove a Page Set� 33
4.1.3 Changing the Order in the Context Display� 34
4.1.4 View a Context Page� 34
4.2 Assign Context to Flex Buttons� 34
4.2.1 Alphabetically View� 35
4.2.2 Grouped View� 36
4.3 Create New from a Template� 37
4.4 Settings� 38
4.4.1 Sono Flex Tab� 38
4.4.2 Communicator Tab� 40
4.4.3 Hardware Tab� 42
4.4.4 Exit Sono Flex Setup� 43
4.5 Help using Sono Flex� 44

The Edit Button Wizard� 45
5.1 Button Text� 46
5.2 Button Picture� 47
5.3 Sound on Click� 48
5.3.1 Sound Type� 48
5.3.2 Text to speak� 48
5.3.3 Miscellaneous� 49
5.4 Saving Your New Page� 50
5.5 Password Protected Page Sets� 51

4

5



Appendices� 52
6.1 Pre-made Contexts in Sono Flex� 52
6.2 Sono Flex for more Devices� 61
6.3 More Content for Sono Flex� 61
6.4 Research on which Sono Flex is based� 61

6



Tobii Sono Flex User’s Manual

6

Introduction
Tobii Sono Flex is a symbol vocabulary based on the Tobii Communicator 
platform.

Tobii Sono Flex is targeted towards individuals in the stages of cognitive and 
linguistic development comparable to that of typically developing children 
between 3 to 6 years of age. The core idea behind Sono Flex can be described 
as a combination of highly frequent words and phrases that are useful in many 
contexts (core vocabulary) and words and phrases that are prepared for specific 
recurring topics (situational vocabulary).

Situational vocabulary is easy to understand, categorize and apply - even 
for very young children and individuals with low abstraction skills. Yet, only 
using situational vocabulary might limit the development of communicative 
independence and is hard to maintain when the vocabulary of an AAC user 
grows. 

Core vocabulary is much more versatile, yet is also more difficult to understand 
and especially to store and find by navigation within categories.

Sono Flex was designed to combine the advantages of both approaches. It 
allows for a combined use of core vocabulary and contextual utterances and 
contains various ways to fine tune the blend in accordance with individual 
needs and development. It enables a growth path into the independent use 
of the communication aid, giving scaffolding structures to help build up a large 
vocabulary while also allowing for a very flexible handling of the same.

The common words and phrases of Sono Flex are available in a main vocabulary 
area, holding approximately 1,000 words, and are sorted by part of speech 
criteria. The categories are set up using the well-proven Fitzgerald Key and are 
color coded accordingly. 

The situational utterances are stored in over 50 pre-made contexts, each 
holding up to 80 words and phrases. Although no further subcategories are used 
for the words of the context pages, they do have an unobtrusive color marking 
in the Fitzgerald Key colors, helping further to prepare the greater use of core 
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vocabulary. Contexts can easily be hidden or made accessible in accordance with 
individual needs or even seasonal requirements.

The starting point into main vocabulary and contexts can be set individually. A 
typical use after an introduction period would be either the Contexts Based 
Home Page with only the situational context vocabulary available or the 
Common Vocabulary Home Page with four different context links being 
quickly available. These quick links, called Flex buttons, can be reassigned easily 
according to the user’s needs and upcoming events.

1.1 Intended Use 
The focus of Tobii Sono Flex is on incorporating a core language, in a natural 
way, but also to make use of a special vocabulary for specific activities the user 
finds engaging and fun.

The Sono Flex Page Sets are designed to:

•	 Always give access to a standard vocabulary of around 1,000 
words

•	 In additional have access to up to 4 preselected contexts
•	 Have flexibility in how many of the contexts the user should be 

able to select themselves

Within the package, the user’s caregivers receive guidance on how to create 
their own context specific vocabularies and activities through included templates 
and instructional documentation.

This product is not intended to serve as a substitute for speech-language therapy 
or educational services. The process of language acquisition has been studied 
extensively, as has the role of modeling and language stimulation as tools for 
teaching language. The authors encourage the use of such techniques when using 
this product.

The appropriateness of this product should be determined following a thorough 
assessment of an individual’s needs and abilities.
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1.2 Sono Flex within the Sono Suite
How does Sono Flex relate to Sono Primo and Sono Lexis?

Product Sono Primo Sono Flex Sono Lexis

Dictionary size 

(words being 

simultaneously 

accessible)

Dozens of words Approx. 1000 words 1000 - 5000 words

Navigation Handled by 

caregiver

Simple Complex

Categorization 

principle

No other 

categorization but 

the situation

Situational 

categorization plus 

simple word-

classes, eventually 

individual categories

Sophisticated 

categorization with 

high abstraction 

level, e.g. word-

classes; alphabetical
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1.3 Fitzgerald Key Categorization
The Fitzgerald Key assigns categories, colors and an order of presentation to 
words according to the following criteria

•	 Yellow: People - used in Sono Flex for Pronouns and Persons
•	 Green: Actions - used in Sono Flex for Verbs
•	 Blue: Describing words - used in Sono Flex for Describing 

Words
•	 Purple: Places - used in Sono Flex for Places
•	 Orange: Nouns - used in Sono Flex for three categories of 

nouns 
-- Things
-- Body and Clothing
-- Food and Eating

•	 White: Other - used in Sono Flex for:
-- Time Words
-- Questions

•	 Pink: Social Vocabulary - used in Sono Flex for Quick Phrases
•	 Brown: Short Words - This category combines a number of 

conjunctions, adjunctions and more words.

In Sono Flex the vocabulary categories have been arranged to make it easier for 
the user to sequence words together. The Sono Flex design also reminds the 
user in what order to pick the words.

1.4 Two Different Start Pages

In Sono Flex for Communicator you can use the application with two different 
start pages.

•	 Common Vocabulary Home Page
•	 Context Based Home Page

The manual explains in detail the default Common Vocabulary Home Page 
mode as it offers more complexity, but the individual button functions of the 
Context Based Home Page mode are the same.
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The difference between the two start pages is in the amount that is accessible by 
the end user from the start page.

From the Common Vocabulary Home Page: Categories, Core Words and 
4 Flex buttons with contexts are available.

From the Context Based Home Page: only contexts are available.

The Common Vocabulary Home Page is the default start page, but you 
can switch between the different start pages in the Control panel, see Chapter 4 
Sono Flex Control Panel.

Giving the care giver the ability to choose between alternative start pages, one 
with less and one with more complexity, allows the program to grow along with 
the user’s ability. 

Starting an early user on the Context Based Home Page allows for a 
smooth transition between situational, context based, communication into the 
more versatile “categorized core vocabulary with additional contexts available” 
communication of the Common Vocabulary Home Page. 

This follows the regular learning curve of preliterate AAC users, and assists with 
growth and learning.
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Getting Started with Sono 
Flex
2.1 Installing, Running and Updating Sono Flex

2.1.1 Installing Sono Flex from a CD

1.	 Insert the Tobii Sono Flex CD into your CD drive. The 
installation program will start automatically.

2.	 Follow the directions on the screen, clicking Next until the 
installation program completes the installation for you.

3.	 When you see the message that Tobii Sono Flex has been 
successfully installed, click Finish, then remove the Tobii Sono 
Flex CD.

2.1.2 Running Sono Flex
Tobii Sono Flex can be started simply in two different ways; from either: 

•	 The Start Menu in the Windows Environment
•	 The Communicator View Ready-Made Page Sets page

From the Start Menu in the Windows Environment:

1.	 Select Start Menu > All programs > Tobii > Sono Suite
2.	 Select either the Sono Flex or the Sono Flex Control Panel

You may also drag out the icons from the Start Menu to your Desktop and 
make quick access shortcuts to the Sono Flex or Sono Flex Control Panel 
if you wish.

2
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From the Communicator View Ready-Made Page Sets page:

1.	 Open Communicator by selection the Communicator shortcut 
Icon on your desktop, , or from within the Tobii folder in the 
Start Menu.

2.	 In the Communicator Welcome Page, select View Ready 
Made Page Sets.

3.	 Select the Symbol tab
4.	 Select either the Sono Flex Vocabulary icon or the  

Sono Flex Control Panel icon.
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2.1.3 Updating Sono Flex or Communicator
Tobii Technology regularly releases updated versions of Sono Flex.
Whenever your PC is connected to the Internet you can check for the most 
recent version of Sono Flex or Communicator and update your installation.

1.	 In Communicator, click Help > Check for updates.
2.	 You get a message saying that Communicator will need to close 

to check for updates.
3.	 Click OK.
4.	 Follow the directions on the screen.

2.1.4 Activating Sono Flex
When you purchase Sono Flex for Communicator you will receive an activation 
key for the software. If you do not have a key, you can start a 30 days trial 
period.

Start the Licenses Manager, then select Activate and follow the on-screen 
instructions to complete the simple activation process, or use the Evaluation 
Mode temporarily. Each serial number serves up to three computers, e.g. the 
user’s communication device, the therapist’s laptop, and an assistant or teacher’s 
computer.

Your serial number can be found on the CD box. To move the licence to a 
new computer, first deactivate the current license. 
After successful installation, you are advised to ensure  that your software is up 
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to date. Select Help > Check for Updates and perform this check regularly.

The activation dialog will appear each time you start Communicator until you 
activate the program. Here you will see how many days remain in the trial, and 
you can at any time choose to activate the software with a purchased serial 
number. If you want to continue using the trial version, select Ctrl + Alt + F10.

2.2 Quick Guide

2.2.1 Using Sono Flex to Communicate
To use Sono Flex to communicate, follow this procedure: 

1.	 Lookup the each word/phrase you want to communicate, by 
navigating through the different pages at hand.

2.	 Select the word/phrase. The selected word/phrase will appear in 
the message window.

3.	 If needed, use the Word Magic button to get correct type of 
word.

4.	 Repeat step 1 - 3 until you have put together your phrase. 
5.	 Press the message window to speak your phrase.

2.2.2 Exiting Sono Flex
To exit Sono Flex, follow this procedure:

1.	 Select the More Contexts button. 
Skip if the Home Page is set to Context Display Home Page.

2.	 Select the Links and Options button
3.	 Select the Exit button.
4.	 Select the Exit - Yes! button.
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Using Sono Flex
By design Tobii Sono Flex allows for different setups of the user interface, 
different starting points and individual access options. Therefore this chapter 
does not describe one narrow usage path of Sono Flex, but lists all its functions. 
Not all of the following elements will be available to all users – in accordance 
with the selected settings in the Sono Flex control panel, see Chapter 4 
Control Panel.

It is recommended to personalize Sono Flex. For example in the “About me” 
context the symbols of family members can be changed into a pictures of the 
end user family members by using The Edit Button Wizard, see Chapter 5 
The Edit Button Wizard.

3.1 Common Vocabulary Home Page (Default)
The Common Vocabulary Home Page is the access page for the user. On the 
Home page, the user will be able to make use of all the Sono Flex vocabulary, 
containing the Main Vocabulary and the Flex Context buttons.

1.2

1.1

3

4 65

2

7

3
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1.	 Common Vocabulary
1.1	 Two (2) rows of Fitzgerald key grouped vocabulary 

category buttons
1.2	 Two (2) rows of Core Word buttons

2.	 Four (4) Flex Context buttons
3.	 One (1) Word Magic/Grammar button
4.	 One (1) Message window/speak button
5.	 Two (2) Erase buttons
6.	 One (1) More Context button

3.1.1 Fitzgerald Key Category Pages (1.1)

The categories and color codes used in Sono Flex are: 

•	 Yellow: Pronouns and Persons
•	 Green: Verbs
•	 Blue: Describing words
•	 Purple: Places
•	 Orange: Nouns - three categories 

-- Things
-- Body and Clothing
-- Food and Eating

•	 White: Other - two categories
-- Time Words
-- Questions

•	 Pink: Quick Phrases
•	 Brown: Short Words
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Depending on the category, the vocabulary will be structured differently by 
default. For example: Nouns words are grouped together in subcategories like 
fruits, body parts, etc. For Verbs, the most common verbs will be located on 
the first page and, for pages 2 – 6, the rest are sorted in alphabetic order.

Access each Fizgerald Key Category page by selecting the desired page from the 
Home page.
On the selected page the symbol for the page will be shown in the top left 

corner. For example, if the Pronouns page is selected, the    will be shown 
in the top left corner. 

Each Fizgerald key category page consists of one to six pages. Navigate through 

the pages by using    (next page) or    (previous page). In the bottom 

right corner on the last page a    button will be shown.

To use a word from the context page in your communication, select the word 
and the selected word will appear in the message window. You will automatically 
be returned to the Home page.

3.1.2 Core Words (1.2)

“Core Words” are words that will be use over and over across numerous 
situations.  They are a small number of flexible words that make up a large part 
of what is communicated.
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The “Core Words” on the Home page are, from left to right:
First row: I, be, do, like, not and How?
Second row: it, can, have, want, to and What?

To use a Core Word in your communication, just select the Core Word and the 
selected Core Word will appear in the message list.
The “Core Words” are color coded according to Fitzgerald Keys as well.

3.1.3 Flex Context Buttons (2)
On the Home Page there are four Flex Context buttons.  
These buttons can be set up as:

•	 4 static (locked for the user), only caregiver defined
•	 1 user and 3 caregiver defined
•	 2 user and 2 caregiver defined
•	 3 user and 1 caregiver defined
•	 4 user defined

Access each context page by selecting the desired Flex Context 
buttons from the Home page.

On the selected Flex Context page the symbol for the page will be 
shown in the top left corner. For example, if the “About me” page 

is selected, the    will be shown in the top left corner.

Each context page consists of three pages. Navigate through the Flex Context 

pages by using    (next page) or    (previous page).

To use a word from the Context page in your communication, just select the 
word and the selected word will appear in the message window.

To see how the user can change the Flex Context Pages, see section 3.2.1.1 
Changing a Flex Context Page
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3.2 Context Based Home Page
The Context Based Home Page will be the Home Page for the user if that 
setting in the Control Panel is chosen. On the Home Page, the user will be able 
to make use of all the chosen Sono Flex Context pages and also be able to train 
in using the Common Vocabulary Home Page. 

3

1

4

8

65

2

7

1.	 Context pages
2.	 Access to Common Vocabulary
3.	 One (1) Word Magic/Grammar button
4.	 One (1) Message window/speak button
5.	 Erase button (Clear All)
6.	 Erase button (Delete Last)
7.	 One (1) Link & Options button
8.	 Quick Phrases

Access each context page by selecting the desired Context page.

Navigate through the available Flex Context pages by using    (next page) 
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or    (previous page).
On the selected Context page the symbol for the page will be shown in the top 

left corner. For example, if the “About me” page is selected, the    will be 

shown in the top left corner.
Each context page consists of three pages. Navigate through the Flex Context 

pages by using    (next page) or    (previous page).

To use a word from the Context page in your communication, just select the 
word and the selected word will appear in the message window.

More Contexts can be added from the Control Panel, see section 4.1 Context 
Display.
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3.3 Common Functions

3.3.1 Word Magic button (3)
With the Word Magic button, the user can change the last selected word into 
its correct grammatical form.

First select the    (Word Magic) button, then select the correct form of 
the word. 

3.3.2 Message window/speak button (4)
In the message window, all selected words will be displayed. To speak the 
message, select the message window.

3.3.3 Erase button
There are two different kind of erase buttons on the Home page.

3.3.3.1 Clear All (5)
To clear the whole message window, select the    (Clear all) button.
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3.3.3.2 Delete Last (6)
To delete the last word entered in the message window, select the    
(Delete last) button.

3.3.4 Common buttons
There are some common button through out Sono Flex that have the same 
function where ever they appear. 

3.3.4.1 Home Button

Select the    (Home) button to return to the set Sono Flex Home Page. 

3.3.4.2 Back Button

Select the    (Back) button to return to the previous Page Set. 
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3.4 Context Display Page (More Contexts)

Select the    (More Contexts) button from the Common Vocabulary 

Home Page to enter the Context Display page.

The Context Display Page will have two different looks:

•	 Flexible Contexts (user can define Flex buttons)
•	 Static Context (only caregiver can define Flex buttons) 

3.4.1 Context Display Page, Flexible Contexts

1

4

2

3

65

1.	 Page indicator
2.	 Home button
3.	 Flex Context buttons
4.	 Available Contexts
5.	 Volume adjustment buttons
6.	 Links and Exit buttons
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Select the    (Home) button to return to the Home page. 

3.4.1.1 Changing a Flex Context Button (3, 4)
Depending on the settings, the user can be allowed to change between 1 and 
4 Flex Context buttons. In the following example, the user can change all four 
Flex Context buttons. Even if the user can change less Flex Context buttons, the 
principle is the same.

To change a Flex Context button, follow this procedure:

1.	 Select which Flex Context (3) to change (to the right of the 
screen). The selected button and arrow will change color to 
green.

2.	 Select a Flex Context (4) from the Available Contexts list for the 
button.

Navigate through the available Flex Contexts by using    (next page) or  

  (previous page).

Select the    (Home) button to return to the Home page. 

If the More Contexts page on the Common Vocabulary Page is accessed when 

the Context Display Home Page is set as Start page there will be a    
(Back) button instead. 
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3.4.2 Context Display Page, Static Context
If the Flex buttons are Static (only caregiver defined),  the Context Display Page 
will look like this. 

3

2

1

1.	 Home button
2.	 Links and Exit buttons
3.	 Available Contexts

Access each context page by selecting the desired Context.

Navigate through the available Flex Context pages by using    (next page) 

or    (previous page).

On the selected Context page the symbol for the page will be shown in the top 

left corner. For example, if the “About me” page is selected, the    will be 

shown in the top left corner.
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Each context page consists of three pages. Navigate through the Flex Context 

pages by using    (next page) or    (previous page).

To use a word from the Context page in your communication, just select the 
word and the selected word will appear in the message window.

Select the    (Home) button to return to the Home page. 
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3.5 Links and Options

2

1 5

6

43

1.	 Page indicator
2.	 Ready Made Communicator pages
3.	 Volume adjustment buttons
4.	 Back to options page
5.	 Home button
6.	 Exit button

3.5.1 Ready-made Communicator Pages
These are links to the Ready-made Communicator Page Sets that are selected in 
the Communicator set up wizard.

The Ready-made Communicator Page Sets available will be shown in this area.

Select a Ready-made Communicator page to start desired feature.

Navigate through the available Ready-made Communicator pages by using  

Chapter 3   Using Sono Flex



Tobii Sono Flex User’s Manual

28

  (next page) or    (previous page).

When exiting the desired feature the Ready-made Communicator pages will 
appear again.

More information about the Communicator set up wizard can be found in 
section “4.4.2 Communicator Tab”.

3.6 Adjusting the Volume
Volume adjustment can be made on the More Contexts or the Links and 
Options page. 

Adjust the speakers volume by selecting:

21 3

1.	 Low volume
2.	 Medium volume
3.	 Max volume

Select the    (Home) button to return to the Home page.
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3.7 Exiting Sono Flex

12 3

4

1.	 No - Do More button (Return to Sono Flex, Links and Exit Page)
2.	 Yes - Exit button
3.	 Control Panel button (If enabled in settings)
4.	 Back to Home Page

3.7.1 Exiting Sono Flex
To Exit Sono Flex, follow this procedure:

1.	 From the Home Page, select    (More Contexts) button. 
Skip if the Home Page is set to Context Display Home Page.

2.	 From the More Contexts page, or Context Display Home 

Page select    (Links & Options) button. 

3.	 From the Links and Exit page, select    (Exit) button. 

4.	 From the Exit page, select    (Yes - Exit) button.
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3.7.2 Accessing the Control Panel
To access the Control Panel from within Sono Flex, follow this procedure:

1.	 From the Home Page, select    (More Contexts) button. 
Skip if the Home Page is set to Context Display Home Page. 

2.	 From the More Contexts page or Context Display Home 

Page, select    (Links and Options) button. 

3.	 From the Links and Exit page, select    (Exit) button. 

4.	 From the Exit page, select    (Control Panel) button. 

To be able to access the Control panel from within Sono Flex, a setting must 
selected in the Control panel. More information can be found in section “4.4 
Settings“.
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Sono Flex Control Panel

4.1 Context Display

The Caregiver can view which Flex Context pages that are made available for 
the end user from within Sono Flex.

Navigate through the available Flex Context pages by using    (next page) 

or    (previous page).

4.1.1 Add new Flex Context Page
There are 50 pre-made Context Pages delivered within Sono Flex, see section 
“6.1 Pre-made Flex Context Pages”:

Select    (Add) button to add a Context Page to the available Flex 
Context Pages.

4
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4.1.1.2 Alphabetic View

Select a Context Page to add from the Sono Flex Contexts or My Page Sets Tab.

The selected Context Pages will be marked with    (checked) in the right 
button corner.

Select the Close button when finished.
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4.1.1.2 Grouped View
The grouped view is only available for the Sono Flex Contexts Tab and not for 
the My Page Sets Tab.

Grouped view - Overview Grouped view - Page sets

First select a group on the Sono Flex 

Contexts Pages.

Next select a Context Page to add.

The Selected Context Page will be marked 

with    (checked) in the right button 

corner.

To return to the Overview page, select    

(Back) in the Sono Flex Contexts Tab.

Select the Close button when 
finished

4.1.2 Remove a Page Set
To remove a Page Set from the Flex Context Pages, follow this procedure:

1.	 Select the Page Set to remove. The selected Page Set will change 
color from White to Green.

2.	 Select    (Remove) button to remove the Page Set.
3.	 Select OK to remove the Flex Context from the Display 

Context Page.
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4.1.3 Changing the Order in the Context Display
To change the order for a Context Page in the Context Display, follow this 
procedure:

1.	 Select the desired Context Page. The selected Context Page will 
change color from White to Green.

2.	 Select    (Move up) or    (Move down) button to 
change the order for the Context Page.

4.1.4 View a Context Page
To view a Context Page in the Context Display, follow this procedure:

1.	 Select the desired Context Page. The selected Context Page will 
change color from White to Green.

2.	 Select    (View) button to view the Context Page.

4.2 Assign Context to Flex Buttons

On the Assign Context to Flex Buttons access can be enabled for the 
end user to change between 1 and 4 of the Flex Context Buttons by selecting 

the check box in the column End user assignable. If the    (Checked) 
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is visible the end user can change the Flex Context for the button themselves 
in that position on the Context Display Page see section 3.4.1 Context 
Display Page, Flexible Contexts.

Select the Clear button to remove a Flex Context button.

Select the Change button to change or assign a Flex Context button.

If none of the buttons are set to End user assignable the Context Display 
Page will be static, see section 3.4.2 Context Display Page, Static Context

4.2.1 Alphabetic View

Select a Context Page to add from the Sono Flex Contexts or My Page Sets Tab.

The selected Context Pages will be marked with    (checked) in the right 
button corner.

Press the OK button to accept.
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4.2.2 Grouped View
The grouped view is only available for the Sono Flex Contexts Tab and not for 
the My Page Sets Tab.

Grouped view - Overview Grouped view - Page sets

First select a group on the Sono Flex 

Contexts Pages.

Next select a Context Page to add.

The Selected Context Page will be marked 

with    (checked) in the right button 

corner.

To return to the Overview page, select    

(Back) in the Sono Flex Contexts Tab 

Press the OK button to accept.
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4.3 Create New from a Template
Select the Create new from a Template button from the Sono Flex 
Control Panel to open the page in which you can select blank templates of the 
Flex Context pages in order to create your own Page Sets. 

To create a new Page Set from a Template:

1.	 Select any one of the available Templates.
2.	 Choose the background color of your selected Template (you 

have the choice of eight different colors for each Template).
3.	 After your Template opens, right click over the button that you 

wish to edit.
4.	 Select Edit Button... in the pop up list. The Edit Button 

Wizard will open.
5.	 Use the Edit Button Wizard to add images and sound to 

your button (see Help using Sono Flex > The Edit Button 
Wizard for information on how to use it).

6.	 Select the Home button that exists on all Page Sets.
7.	 Select Yes to save your new Page Set.
8.	 Give your new file a name and select Save to save the Page Set 

to your My Page Sets folder. 

You will now have access to this new Page Set from the My Page Sets button 
on the Select Context page of the Sono Flex Control Panel. From there, 
you can select the check box to enable your new Page Set to be a part of the 
Sono Flex Home Page for the access of the end user.
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4.4 Settings
The Settings page consists of three different tabs.

4.4.1 Sono Flex Tab

The Sono Flex Tab in the Settings page presents five options:

•	 Audible Cue on Grammar Buttons
•	 Exit to Control Panel from Vocabulary Page
•	 Return to Home Page after selections in:

-- Categories
-- Contexts

•	 Sono Flex Home Page
-- Change...
-- Start on Common Vocabulary Home Page
-- Start on Context Based Home Page

•	 Reset Sono Flex Page Sets Selections to default

Select the Audible Cue on Grammar buttons to turn ON or OFF the 
Audible Cue.

Select the Exit to Control Panel from Vocabulary Page to turn ON or 
OFF the user access to the Control Panel from the Vocabulary Page.

Select the Return to Home Page after selections in Categories to turn 
ON or OFF the behavior after selecting a word in a Category page.
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Select the Return after selection in Contexts to turn ON or OFF the 
behavior after selecting a word in a Context page.

Select the Sono Flex Home Page - Change button to: 

•	 Reset to original to use the original Common Vocabulary page.
•	 Select from My Page Sets to choose your own created/

changed Page Set as the Common Vocabulary page.

Select Start on Common Vocabulary Home Page to set the Common 
Vocabulary page as default Home Page in Sono Flex.

Select Start on Context Display Home Page to set the Context Display 
page as default Home Page in Sono Flex.

Select Reset Sono Flex Page Sets Selections to default to clear all 
changes made to Sono Flex 
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4.4.2 Communicator Tab

The Communicator tab in the Settings page presents two options:

•	 Select Ready Made Communicator Page Sets for Sono Flex
•	 Make Sono Flex Home Page for this user

Select the Make Sono Flex Home Page for this user button to make 
Sono Flex the Communicator Home Page. This will let you open Sono Flex 
automatically by opening Communicator (if Communicator is configured to 
open the Home Page on start up from the Communicator Setup Wizard).

Select the Select Ready Made Communicator Page Sets for Sono Flex 
button to take a shortcut directly to the Communicator Set up Wizard.

The Communicator Setup Wizard allows you to configure your 
Communicator Home Page and/or startup screen. In this case you can use it, 
for example, to configure Sono Flex to be a part of your Communicator Home 
Page or to be the acting home page or startup page. 
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To use the Communicator Setup Wizard you must follow the instructions 
in Help for Communicator 4 or the Communicator User’s Guide:

1.	 Open the Communicator Setup Wizard by selecting the 
Setup Wizard button.

2.	 Select the Symbol tab, here you will find the icons for the Sono 
Flex Home Page and the Sono Flex Control Panel.

3.	 Select the Help tab, and choose either Help for 
Communicator 4... or User Guide (PDF)...

4.	 Follow the instructions for Using the Setup Wizard.
5.	 As per the instructions, tick to select the Page Sets you want in 

your Communicator Home, or Startup Page, select the type of 
Home Page you want, adjust the Favorites and Order, Adjust 
User Settings, and Start-Up.

6.	 From your new Communicator Home Page you will be able to 
start Sono Flex or configure it to be set as the default Startup 
Page for each time you start Communicator.
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4.4.3 Hardware Tab

The Hardware Tab in the Settings page allows you to control different 
selected hardware settings of the device on which you are running Sono Flex, 
directly from the Sono Flex Control Panel. 

Depending on the Hardware you are using to run Sono Flex, and depending on 
whether or not you are using eye control, there will be more or less hardware 
settings available.

Select a button and follow the on-screen instructions (if available) for assistance.
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4.4.4 Exit Sono Flex Setup
Use the Exit button to exit the Sono Flex Control Panel entirely.

Select the Exit and a dialog will open giving you three choices:

1.	 Exit to Sono Flex Vocabulary Page

-- Select to exit directly to the Sono Flex Vocabulary Page, 
the end user’s Sono Flex access portal

2.	 Exit to Communicator Welcome Page

-- Select to exit to the Welcome Page in Tobii 
Communicator, where you can access Communicator in 
its entirety

3.	 Exit Communicator entirely

-- Select to exit to the Windows Environment, closing Sono 
Flex and Communicator
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4.5 Help using Sono Flex

From all screens of the Sono Flex Control Panel you can select the 
information text in the upper left corner, Help Using Sono Flex, and open 
the following page:

In the Help Using Sono Flex page you can find a few short tips for 
using Sono Flex as well as a link to the PDF version of the Sono Flex For 
Communicator User’s Manual.
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The Edit Button Wizard

As personalization of Page Sets is an essential ingredient for ensuring the 
successful use of AAC systems, we have provided the Edit Button Wizard 
as a way of modifying pre-made pages and creating content for the provided 
“blank” Templates.

The Edit Button Wizard is a simple tool that allows you to change the text, 
picture and sound of an existing button, or add text, pictures and sounds to 
“blank” template buttons.

To use the Edit Button Wizard to modify a button from a Page Set or 
Template in the Sono Flex Control Panel:

1.	 Select and open the Template page, or the page from the Page 
Set, that you wish to edit.

2.	 Right-click on the button you wish to modify and select Edit 
Button from the right-click menu. The Edit Button Wizard 
will open.

5
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-- On a touch screen device you may be able to right-click 
by long pressing the selection on the screen

3.	 Read the Edit Button Wizard welcome page (above) and 
select Next > (you can choose to Skip this page next time 
by selecting the check box). The Button Text dialog will open.

5.1 Button Text

Use the Button Text dialog of the Edit Button Wizard to add new text to, 
or change the text of, your chosen button.

The button you have chosen to edit will be visible on the left side of the dialog, 
the text field is available on the right side.

You may set Sono Flex (by using Communicator) to call up an on screen 
keyboard whenever there is a text field by selecting View > Use On-Screen 
Keyboard from the Communicator Menu. Toggle the Communicator 
Menu on or off from Sono Flex by right-clicking and selecting Run in 
Window/ Run Full Screen.

•	 After you have finished adding or editing the visible text, select 
Next >. The Button Picture dialog will open.
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5.2 Button Picture

Use the Button Picture Dialog of the Edit Button Wizard to add an image 
to, or change the image of, your chosen button.

The button you have chosen to edit will be visible on the left side of the dialog, 
the collection of available SymbolStix® images based on the word you have 
chosen will be seen on the right.

By default the Edit Button Wizard will automatically search for images 
relating to the word that you have chosen as your Button Text. 

If there are no images available that match your chosen text, you can search for 
any other words that might relate to similar images by using the Search For: 
text field (e.g. Bed instead of Sleep). This will not change your previously chosen 
Button Text.

You can also remove the present image by selecting the Remove Picture 
button or even search your hard drive or external drive for other pictures or 
images than those available through the SymbolStix® library by selecting the 
Browse... button.

•	 Select your chosen image from the image field (or through the 
Browse... button). The image or picture of your chosen button 
will change.

•	 After you have finished adding or changing images select Next>. 
The Sound on Click dialog will open.
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5.3 Sound on Click

Use the Sound on Click dialog of the Edit Button Wizard to add sound to, 
or change the sound of, your chosen button. 

Sono Flex comes with an extensive library of live-recorded sounds for its most 
common words and phrases and makes use of the Acapela synthesized speech 
voices. 

5.3.1 Sound Type
In the Sound type section of the Sound on Click dialog, use the selector 
bubbles to choose between having No sound on the button, using 
Synthesized speech to speak your chosen Button Text, using Recorded 
sound to speak your chosen Button Text, or even importing an Sound file 
from your computer to play when your chosen button is selected. 

Select the Revert to synthesized speech for missing sounds check box 
when you have chosen Recorded sound to specify that the primary sound for 
a Button Text will be a recorded sound, but that if there is no recorded sound 
available, that text will be spoken by the synthesized speech voice. This is the 
default and recommended setting for Sono Flex.

5.3.2 Text to speak
In the Text to speak section of the dialog you can choose the text to be 
spoken when the button is selected. 
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Choose Speak text on button to choose the same text as the written 
Button Text that you had previously specified. 

Choose Speak this text: text field to add other text to be spoken instead of, 
or in addition to, the written Button Text (e.g. on the Button Text you could 
have written “Sleep”, but you choose for the sound upon selection of the 
button to be “ I really want to sleep”). 

If you write text in the text field that does not have a corresponding recorded 
sound, you will be prompted to record a new one yourself.

5.3.3 Miscellaneous
In the Miscellaneous section of the dialog you can choose to test the sound 
you have chosen for the button with the Test Sound button, record a new 
sound with the Record Sound button or go to your own list of your own 
recorded sounds with the Go to My Recorded Sounds... button.

You can also select the check box to Prevent user interaction while 
sound is playing. This makes it impossible for the end user to select another 
button until the sound from this button has finished playing.

To record a new sound:

1.	 Select the Record Sound button. The Record New Sound 
dialog will open.

2.	 Select the Record button. Your computer’s default, or assigned 
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external, microphone will be used to make the recording.
3.	 Select Stop when you have finished recording.
4.	 Select Play to test the recorded sound.
5.	 Select Finish to return to the Sound on Click dialog of the 

Edit Button Wizard or Cancel to return without saving your 
new sound.

Your new sound will now be the recorded sound that plays on the button when 
it is selected. It will also have been added to My Recorded Sounds and can be 
accessed there for later use by selecting the Go to My Recorded Sounds... 
button from the same dialog of the Edit Button Wizard. 

•	 Select Finish to complete and save your edited, or newly 
created, button in the Edit Button Wizard or select Cancel 
to exit back to your chosen page or Template without saving.

5.4 Saving Your New Page
You new button will now be ready to use on your new Page Set. 

When you select the Home button present on all Sono Flex Page Sets you will 
be prompted to save the new Page Set.

1.	 Select Yes to save, No to discard, or Cancel to return to the 
page.

2.	 By default your new page will be saved in your My Page Sets 
folder. Choose a name and select Save (you can of course save 
the file anywhere on your computer if you so choose). 

You will now be able to access your new Page Set from the My Page Sets Tab 
on the Context Display > Add page or Assign Context to Flex Button > 
Change... page of the Sono Flex Control Panel.
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5.5 Password Protected Page Sets
Some of Sono Flex’s Page Sets are locked for editing by a password. We have 
done this because these Page Sets contain complicated action scripts and are 
difficult to customize. If you want to customize the locked Page Set anyway, you 
are free to do so, at your own risk.

The password for editing locked Page Sets is:    flex

We cannot provide support if there is an error in a password protected Page 
Set that you have changed.
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Appendices

6.1 Pre-made Contexts in Sono Flex
Contexts are situationally based,  or organizationally based,  groups of words,  
categorized into one Page Set relevant to the Sono Flex user group in general,  
or (for custom made contexts) the individual user in particular.  The pre-made 
contexts are mostly common situations in which a user of this level of cognitive 
and linguistic development would be involved based on the shared clinical and 
family experiences of the authors of Sono Flex, as well as on the writings of the 
various authors listed in the Research Bibliography.

Not all contexts are completely situationally based,  thus they are not called 
“Situations”.  A user might want to make their own context  called “Things that 
Fly”,  “Things that are Blue” or “Words I learned with Teacher”,  which might 
span a number of different experiential situations.  

The following is a list of the Pre-made Contexts in Sono Flex with a small 
description and their group label:
  

Symbol Description Belong to group in 

Grouped view

4th of July Holiday

About me Personal

6
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Symbol Description Belong to group in 

Grouped view

Art School

Bath Personal

Beach Nature

Bedtime Personal

Birthday Holiday

Blocks Activity

Board games Game
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Symbol Description Belong to group in 

Grouped view

Breakfast Food

Brush teeth Personal

Bubbles Activity

Cars Activity

Chat Teen

Christmas Holiday

Circle time School
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Symbol Description Belong to group in 

Grouped view

Clay Activity

Cooking Activity

Dinner Food

Doctor Personal

Dolls Activity

Easter Holiday

Farm Activity
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Symbol Description Belong to group in 

Grouped view

Fashion Teen

Fruit and snack Food

Get dressed Personal

Go fish Game

Guess who Game

Gym School

Halloween Holiday
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Symbol Description Belong to group in 

Grouped view

Hide and seek Game

Housekeeping Activity

I spy… Game

Jokes Other

Keyboard Other

Lunch Food

Math School
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Symbol Description Belong to group in 

Grouped view

Movies Teen

Mr. Potato Head Game

Music School

Nature walk Nature

Outdoor games Game

Personal care Personal

Playground Activity
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Symbol Description Belong to group in 

Grouped view

Puzzles Activity

Questions Other

Quick comments Other

Quick link Other

Reading School

Shopping Activity

Snow Nature
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Symbol Description Belong to group in 

Grouped view

Sports Activity

TV Activity

Vacation Holiday

Weather Nature

Video games Game

Zoo Activity
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6.2 Sono Flex for more Devices
Tobii Sono Flex is available for more devices.

See www.tobii.com for more information.

6.3 More Content for Sono Flex
You can find and share Page Sets and pages for Sono Flex on Tobii Technology’s 
Page Set sharing web site www.pagesetcentral.com. 
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